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Chapter 1. Introduction  

This chapter presents introductory information to be reviewed prior to unpacking your Cellometer® Auto T4 
instrument. It includes a product overview, lists contents of shipping container, identifies symbols/abbreviations 
used on both the device label and instrument, and provides a summary of topics contained in this user manual. 

AUTO T4 SYSTEM OVERVIEW 

Cellometer® Automated Cell Counters incorporate the basic principles of Imaging Cytometry traditionally used in 
manual cell counting via hemocytometer into a suite of instruments designed to simplify the cell counting process. 
By capturing multiple images of the cells to be counted, users can adjust parameters based on cell morphology and 
perform reanalysis as necessary. Cellometer Cell Counting Chambers are equivalent to all four corner squares of a 
hemocytometer and are disposable, thus saving time and effort, and eliminating any risk of cross-contamination. 

Using Brightfield imaging and pattern-recognition software, the Cellometer Auto T4 quickly identifies individual 
cells and accurately calculates Cell Count, Mean Diameter (micron) and Cell Concentration (cells/mL). Customizable 
cell type parameters are designed to assist with the declustering of clumpy cell lines. For cultured cells stained with 
trypan blue, the Auto T4 simultaneously calculates Live/Dead and Total cell counts, Viability (%), and Live and Total 
cell concentrations, including a helpful graphic overlay that may be used to highlight counted live and dead cells 
with color-coded outlines in the image being viewed. 

The small footprint of the Auto T4 is designed to fit in small lab spaces and Cellometer Auto software can be 
loaded on most computers. With an Operating Computer connected to the instrument via USB cable, the system 
can be linked to a network for accessing external files, printers and storing count results. For laboratories that 
require QC access and audit controls, optional GMP/GLP software can be added to the Auto T4 for tracking audit 
details, offering multi-layer access control and allowing automatic printing of data/images using custom templates. 

Intended Use 

Intended use of the Auto T4 is to count clean cell lines and cultured primary cells such as CHO, Jurkat, C6, HT29, 
DLD, KAT4, GHOST, MCF-7 and more. It can also provide total cell count and viability using trypan blue. 

Personnel operating this instrument are encouraged to familiarize themselves with device controls and operation. 
Ensure that users can identify all components associated with the instrument, perform adequate adjustments and 
understand performance criteria. If issues are encountered, follow the Troubleshooting guidelines on page 57 to 
restore performance if instrument does not meet or exceed defined performance criteria. 

WARNING: Use of controls or adjustments or performance of procedures other than those specified 
herein or by Nexcelom Bioscience LLC. may result in a hazardous process. 
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CONTENTS OF SHIPPING CONTAINER 

Cellometer Auto T4 Instrument 

Power Cord (Figure 1) 

USB Connector Cable (Figure 2) 

USB Drive 

 Contains Cellometer Auto T4 Software; used to  
      install software on an Operating Computer not  
      provided by Nexcelom  

Note: Store USB drive where it can easily be located  
if software needs to be installed on another computer. 

Cellometer Auto T4 User Manual and Quick Start Guide 

 Available as .pdf files on the USB Drive with software 

Focus Guide 

 Graphic sheet intended to help users adjust instrument focus 

Cell Counting Chambered Slides (Figure 3) 

 One box of 75 disposable slides; each slide contains 
      two separate counting chambers 

Nexcelom-provided Laptop (Figure 4) 

If a laptop was purchased from Nexcelom (optional) along 
with the instrument, it will be shipped in a separate box. This 
laptop will have the specifications listed below: 

• Windows 10 OS 64 bit 
• Intel Core Processor i3-8130U (2.20GHz) 
• 4GB RAM 
• 500GB7200RPM SATA NoteBook Drive 
• 15.6” 1366 x768 HD LED Wide Screen 

 
 

If a laptop was not purchased from Nexcelom, the following minimum specifications are required for an 
Operating Computer: 

• Windows 7, 8, or 10 PC  
• 1.6 GHz or higher processor 
• 2GB RAM (4GB RAM or higher recommended) 
• USB 2.0 or higher 
• Display resolution: 1024 x 768 pixels or higher 

Note: An Intel Mac with Parallels/Windows may be substituted for a Windows computer, but this setup is 
not recommended. 

 

Figure 2. USB Connector Cable Figure 1. Power Cord 

 

Figure 4. Nexcelom Laptop 

Figure 3. Chambered Slide 
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ABOUT THIS USER MANUAL 

This Cellometer Auto T4 User Manual provides information on the following topics: 

• System Overview and Shipping Contents • Basic Counting and Analysis Workflow 

• Potential Hazards and Safety Information • Cell Types and Adjustment Parameters 

• Components, SN Label and System Specs • Saving/Exporting Data and Image Files 

• Site Preparation and Unpacking • Cleaning, Maintenance and Storage 

• Software Installation and First-time Use • Troubleshooting and FAQs 

• Key Software Screens and Menus • Nexcelom Support Services and Contacts 

• Slide Preparation and Loading Samples • Consumables, Conformity and Warranty 
 

The following Precaution Signifiers are used in conjunction with the  symbol in this user manual:  

IMPORTANT: Note indicating that to skip or move past <content_of_note> may result in improper 
functionality of the instrument. 

CAUTION: Note indicating that <content_of_note> may damage instrument to the point where it will 
no longer function as expected. 

WARNING: Note indicating that <content_of_note> may permanently damage instrument and 
cause personal injury or harm. 
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GLOSSARY OF ABBREVIATIONS 

The following abbreviations may be displayed on the shipping container, on the Cellometer Auto T4 device label or 
in this user manual. 

A Amperes kW Kilowatt 

AC Alternating Current lbs Pounds 

ANSI American National Standards Institute PC Personal Computer 

AO Acridine Orange PI Propidium Iodide 

API Application Program Interface LED Light-emitting Diode 

@ at MHz Megahertz 

BR Brightfield µL Microliter 

°C Degrees Celsius µm Micron  

Cm Centimeter mL Milliliter 

EU European Union mm Millimeter 

FAS Field Application Scientist ms Millisecond 

FCC Federal Communications Commission  nm Nanometer 

FDA Food and Drug Administration  OQ Operational Qualification 

FL Fluorescence OSHA Occupational Safety and Health 
Administration 

GUI Graphical User Interface P/N Part Number 

Hz Hertz SN Serial Number 

IFU Information for Use SW Software 

IPA Isopropyl Alcohol US United States 

IQ Installation Qualification USB Universal Serial Bus 

Kg Kilogram V Volts 

kHz Kilohertz WEEE Waste Electrical and Electronic 
Equipment 
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GLOSSARY OF SYMBOLS 

The following international symbols may be displayed on the shipping container, on the Cellometer Auto T4 device 
label or in this user manual. 

 

Keep Dry ISO0626 per  
EN ISO 15223-1. Located on 
shipping container. 

 

This End Up ISO0623 per 
EN ISO 15223-1. Located on 
shipping container. 

 

Fragile, Handle with Care 
ISO0621 per EN ISO 15223-1. 
Located on shipping 
container. 

 

FCC Part 15 Supplier 
Declaration of Conformity. 
Located in user manual.   

Declaration of Conformity to 
Medical Device Directive 
93/42/EEC. Located on SN 
label and in user manual.  

ISO 9001:2015 Certified 
 

 

Follow Instructions for Use. 
Located in user manual.  

On—Power Connection to 
Mains. Located on 
instrument’s Power Switch. 

 

Off—Power Disconnection 
from Mains. Located on 
instrument’s Power Switch. 

 
Polarity DC Power 
Connector IEC 60878. 
Located on SN label.  

Serial Number ISO2498 
per EN ISO 15223-1. 
Located on SN label.  

Manufacturer ISO3082 per  
EN ISO 15223-1. 
Located on SN label. 

 
WEEE per EN50419.  
Located on SN label.     
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Chapter 2. Equipment Safety 

As with any equipment that involves moving parts, there are potential hazards involved in the operation and 
maintenance of this instrument. This chapter identifies potential hazards and suggests precautions to avoid them. 

POTENTIAL HAZARDS 

This section describes instrument safety features designed to minimize potential hazards. Before using the system, 
familiarize yourself with this information. 

WARNING: No modification of this equipment is allowed. Modification of equipment can result in 
improper operation causing possible injury. 

In the United States, the facility operating the instrument should follow all OSHA Manual lines and 
applicable ANSI standards for the safe use of this instrument.  

Customer and operator agree that it is their sole responsibility to fully understand and comply with 
local, state, and federal laws, rules and regulations in the use of this system. 

Cables and accessories not specified within the instructions for use with this instrument are not 
authorized. Using other cables and/or accessories may adversely impact safety and performance. 

Note: The Auto T4 instrument should not be used adjacent to or stacked with other equipment unless specified by 
Nexcelom. If the system must be used adjacent to or stacked with other equipment, then observe the instrument 
in its configuration to verify instrument operation is normal and functions as expected. 

Electrical Hazard 

No part of the exterior housing should be removed. Do not open the instrument cover. Contact Nexcelom Support 
at +1 (978) 327-5340 or via email: support@nexcelom.com 

WARNING: To avoid the risk of electrical shock, this equipment must only be connected to a 
grounded electrical outlet. 

In addition, ensure electrical supply plug is not obstructed and can be reached by users to 
disconnect the device if necessary. 

  

mailto:support@nexcelom.com
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Instrument System Hazard 

Read the instructions, warnings and cautions provided with the instrument before using. 

WARNING: Inspect instruments and cables for breaks, cracks, nicks and other damage before every 
use. This may be done visually under magnification or with a high voltage insulation testing device. 
If damaged, do not use. Damaged instruments or cables may result in injury to the user. 

CAUTION: The instrument is designed to accept only one slide at a time. Do not attempt to load more 
than one slide into the sample slot. Doing so will cause an error and could damage the instrument.  

CAUTION: Do not stack equipment on top of the Instrument or place the Instrument on top of 
electrical equipment. This is an unstable configuration and does not allow for adequate cooling.  

In addition, it is recommended that as much distance as possible be provided between the 
instrument and any equipment emitting a high vibration signature. High levels of vibration may affect 
clarity of the image being viewed.  

WARNING: Do not remove the instrument cover. Contact Nexcelom Support for assistance at  
+1 (978) 327-5340 or via email: support@nexcelom.com 

Servicing Hazard 

No one other than Nexcelom-authorized personnel may service inside the protective cover of the Auto T4 
instrument system.  

CAUTION: Do not pull the system by the connectors. Toppling of the system or causing damage to the 
system may result in the instrument no longer functioning as expected.  

mailto:support@nexcelom.com
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SAFETY INFORMATION 

Personnel operating and maintaining the Auto T4 instrument should be familiar with the safety information 
included in this section.  

Safety Protocols 

Nexcelom assumes no liability whatsoever for any damage, loss or injury resulting from an application of a product 
that is not in strict accordance with the instructions provided with the product. Nexcelom also assumes no liability 
for any damage or injury arising as a result of operator error or mistake, including, but not limited to, injury arising 
from operator’s lack of qualification or as a result of errors or mistakes committed by such operator.  

Read all installation and operation instructions contained in this user manual thoroughly before connecting the 
Auto T4 instrument to the main power connection prior to use. The Auto T4 must be set, regulated and used in 
accordance with the instructions outlined in this user manual. Failure to observe safety warnings and precautions 
may present a risk.  

Only individuals with appropriate safety training and knowledge should operate, assist in the operation of, or 
perform cleaning and routine maintenance of this instrument. Only the operator should be responsible for system 
controls during a procedure.  

Safety Features 

The Auto T4 Instrument offers several safety features to prevent its misuse or unintentional activation. All 
personnel who operate the system should be familiar with these safety features. 

Contact Nexcelom Support for assistance at +1 (978) 327-5340 or via email: support@nexcelom.com 

Federal Communications Commission 
This device complies with part 15 of the FCC Rules. Operation is subject to the following two 
conditions: (1) This device may not cause harmful interference and (2) this device must accept any 
interference received, including interference that may cause undesired operation. 

 
  

mailto:support@nexcelom.com
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Chapter 3. Instrument Description 

This chapter describes the Auto T4 instrument components, device label and system specifications. 

AUTO T4 COMPONENTS 

 

Auto Sample Slot: Chambered slides are inserted through this slot for viewing (accepts only one slide at a time).  
Focus Knob: Radial dial used to focus the camera. 
Power Switch: Controls power going to the instrument. 
USB 2.0 Port: Port used to connect the Auto T4 to the Operating Computer. 
Power Cord Connector Input: Port used to connect the power supply to the Auto T4. 
Device Label: Lists the instrument serial number (SN), model, manufacturer and input power requirement.  

DEVICE LABEL  

 Serial Number 

 
Manufacturer 

 Polarity DC Power Connector 

 
Waste Electrical and Electronic Equipment Directive 

 Conformité Européenne 93/42/EEC   

 

Front View 

Auto Sample Slot 

Back View 

Device Label 

Focus Knob 
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SYSTEM SPECIFICATIONS 

The Auto T4 System is comprised of the instrument connected via USB cable to an Operating Computer used to run 
the instrument software. The Operating Computer can be linked to a network for accessing external files, printers 
and storing count results. 

 Cellometer Auto T4 Cell Counter 

Channels Brightfield 

Number of Channels 1 

Commonly Used  
Compatible Dyes Trypan Blue 

Counting Speed Per Sample <30sec 

Volume (per chamber) 20 µL 

Cell Size/Diameter Range 5 - 60 µm (most mammalian cells) 

Concentration Range 1x105 – 1x107 

Software Cellometer Auto Pattern-recognition software to quickly and 
accurately decluster, identify and count individual cells 

Weight 10.4 lbs (4.7 kg) 

Width 3.5″ (8.9 cm) 

Depth 4.2″ (10.7 cm) 

Height 12.6″ (32.0 cm) 

Input to Power Adapter 100-240 VAC, 50/60 Hz, 0.5A 

Output to Instrument 12 VDC, 1.5A 
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Chapter 4. Unpacking and Site Preparation 

This chapter presents site preparation facility requirements for setting up the Auto T4 system and transporting 
instructions if the instrument must be moved to another location. 

UNPACKING THE INSTRUMENT 

Congratulations on your purchase of one of the best declustering cell counters available! Please ensure you have 
secured the space required to set up the Auto T4. Visit the Cellometer Auto T4 page on our website, click the 
Resources tab and scroll down to find Training Videos for unboxing and getting started with the instrument.  

Our staff would be happy to help you set up your Auto T4. Contact Nexcelom Support for assistance at  
+1 (978) 327-5340 or via email: support@nexcelom.com 

1. Inspect the package to ensure no damage has occurred during shipping, if applicable.  
Contact Nexcelom Support if damage has visibly affected the instrument. 

2. Ensure the box is facing up (i.e., This End Up symbol is facing in the right direction). If not, 
carefully turn the box right side up. Box will weigh approximately 10 lbs (4.7 Kgs). 

3. Open the outer box. 

4. Remove protective packaging. 

5. Remove the inner box.  

6. Open the secondary box to remove the Power Cord, USB Computer Cable and Software USB. 

7. Remove the Auto T4. 

8. Place the Auto T4 in the prepared area (see Facility Requirements on page 14). 

9. Remove the protective seals around the Auto T4. 

10. Insert the Power Cord Connector into the Auto T4. 

11. Plug the Power Cord into a surge protector (recommended) or power outlet.  

12. Obtain the USB 2.0 Computer Cable. 

13. If you have purchased a Nexcelom Laptop or have installed the Cellometer software on a laptop meeting 
Nexcelom minimum specifications, connect the Auto T4 to the laptop using the USB 2.0 Computer Cable.  

Note: If you have not yet installed the software, do not connect the instrument to the computer until directed 
during software installation. 

14. Turn the Auto T4 Power Switch to the ON position. The system is now ready for use. 

Auto T4 IQ/OQ Validation 

Nexcelom Bioscience has designed an Installation Qualification/Operation Qualification (IQ/OQ) validation 
specifically for the Cellometer Auto T4. Our experienced Support team is available to assist your organization 
during set up of the instrument and while performing the IQ/OQ validation. Contact Nexcelom Support for more 
information at +1 (978) 327-5340 or via email: support@nexcelom.com 

https://www.nexcelom.com/nexcelom-products/automated-cell-counters/cellometer-auto-t4-automated-cell-counter/
mailto:support@nexcelom.com
mailto:support@nexcelom.com
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SITE PREPARATION 

Facility Requirements 

Instrument must be plugged directly into a surge protector (recommended) or power outlet. Ensure all cables are 
free from kinks or tangles prior to starting the Auto T4. 

Due to how the instrument is used with liquids, the instrument should be placed on a level surface.  

Keep the area around the Auto T4 clean between, during and post operation.  

Electrical requirements for the Auto T4 are as follows: 

• 0.5 AMP service 
• Wall receptacle voltage between 100 to 240 VAC 
• 50/60 Hz 

 

Note: Voltage requirements vary per region. For international customers, ensure that Power Cord meets local 
regulations or use a suitable replacement. 

Note: The instrument can be disconnected from the mains by disconnecting the Power Cord from the mains plug 
or appliance coupler. 

CAUTION: Do not position the device such so that it is difficult to disconnect from power main. 

Transporting the Instrument 

Prior to transporting the instrument by vehicle, disconnect the main from the wall and package all accessories and 
consumables individually and safely, ensuring cables are also protectively wrapped. Refer to instrument 
dimensions to ensure vehicle to be used for transporting meets these requirements.  

When the instrument is loaded into the vehicle, it should be secured in such a way to prevent the instrument or 
components from shifting during transport. 

WARNING: Care should be taken while moving or transporting the instrument to prevent damage 
to the instrument and/or possible injury. 

Disposal of Waste Electrical and Electronic Equipment 

To comply with European Commission Directive 2012/19/EU on Waste Electrical and Electronic 
Equipment (WEEE) and other country and state regulations, do not dispose of this equipment in 
any location other than designated waste locations. Contact Nexcelom Support for proper product 
disposal at +1 (978) 327-5340 or via email: support@nexcelom.com 

mailto:support@nexcelom.com
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Chapter 5. Operation 

This chapter describes installing the software and steps to be performed when using instrument for the first time. 

WARNING: Never force the door open or place a foreign object inside the Auto Sample Slot. Should 
anything get stuck or spill inside the sample slot, power OFF the instrument and contact Nexcelom 
Support for service at +1 (978) 327-5340 or via email: support@nexcelom.com 

INSTALLING THE SOFTWARE 

If the Operating Computer was purchased from Nexcelom along with the instrument, the software was pre-
installed on the laptop and you can skip this section. Continue to Using Instrument for the First Time on page 17. 

Note: Ensure that instrument is not connected to the computer during software installation until specified. 

To install the Cellometer software on a computer that was not purchased from Nexcelom, follow these steps. 

1. Insert Software USB Drive that was included with the instrument into USB port of the Operating Computer. 

2. Extract files contained on the USB to the computer desktop. 

3. On the desktop of Operating Computer, double-click the Cellometer_version.exe file (where version 
represents the version being installed).  

4. Click Next to begin the Auto T4 software installation.  

mailto:support@nexcelom.com
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5. Click Install to install the instrument software on the hard drive of the Operating Computer. A screen 
containing prerequisite software to be installed on your computer may be displayed. Click Install to continue. 

6. When prompted, click OK to check for prior versions of Cellometer Auto T4 software.  

7. Click Finish to exit the installer. 

8. Confirm that Cellometer Auto software icon now appears on desktop of Operating Computer.  

9. Remove the Software USB and store it according to personal/company guidelines.  

10. Plug power cord for the Auto T4 instrument into a surge protector (recommended) or outlet and power ON. 

11. Once software installation is complete, connect USB 2.0 cable between the Auto T4 and a USB 2.0 port on the 
Operating Computer. 

Windows automatically installs necessary USB drivers on to the instrument which may take up to several minutes. 
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USING INSTRUMENT FOR THE FIRST TIME 

Starting the Software 

1. On the desktop of Operating Computer, launch the Auto T4 software by double-clicking  
the Cellometer Auto software icon.  

2. Enter instrument Serial Number from the device label into the input fields. The device label can be  
found on back of the instrument. 

3. Click Done to save the instrument Serial Number. 

4. A pop-up message will appear indicating a background image needs to be taken before counting.  
Click OK to continue. 
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Taking a Background Image 

After initial setup of the instrument, you must take a background image of the system by itself (without the cell 
counting chambered slide inserted) to normalize the cell counter. Unless the instrument is moved to a new 
location, there is generally no need to take another background image. 

1. On the desktop of Operating Computer, launch the Auto T4 
software by double-clicking the Cellometer Auto icon. 

2. Navigate to the Options Menu and select the  
Take Background Image option. 

3. Remove the chambered slide from the instrument, if applicable.  

4. Click OK to confirm the Auto Sample Slot is empty. 

5. The system automatically takes the background image.  
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6. Once the image is complete, a pop-up message indicates the background image has been saved. Click OK.  

7. Click the Display Image button to view the background image taken.  

8. Confirm that the background is a uniform gray color.   

If there is any discoloration (e.g., light/dark areas) of the image, contact Nexcelom Support for assistance at 
+1 (978) 327-5340 or via email: support@nexcelom.com 

9. Return to the Home screen to begin counting samples.  

 

  

mailto:support@nexcelom.com
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Chapter 6. Software GUI Elements 

This chapter presents key graphical user interface (GUI) menus and screens available in the Auto T4 software.  

Note: The Auto T4 software used to run the instrument must be installed on the Operating Computer before you 
can use the GUI. See Installing the Software on page 15 for details. If the Operating Computer was purchased from 
Nexcelom along with the instrument, the software was pre-installed on the laptop and is ready for use. 

HOME SCREEN 

 The Home Screen (also referred to as the main screen) in the Auto T4 software is described below. 

 

1 Display Image Button – Shows cells currently in the counting chamber. Not enabled if a saved image 
has been loaded for display. 

2 Count Button – Initiates counting procedure. Not enabled if a saved image has been loaded for display. 

3 Test Viability – Indicates that a viability stain has been used. 

4 Cell Type – Identifies cell type parameters to be used when counting. 
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5 Sample ID – Allows entry of a unique sample identifier. 

6 Dilution Factor – Allows entry of final dilution factor for cell sample to calculate accurate concentration. 

7 Live/Dead Count – Displays numbers of live and dead cells found. Displayed only if Test Viability  
is selected. 

8 Cell Count or Total Cell Count – Displays total number of cells counted in the images taken. Display of 
field toggles based on whether Test Viability is selected.  

9 Mean Diameter (micron) – Identifies mean diameter of counted cells in microns. 

10 Viability (%) – Identifies percent viability of cell sample. Displayed only if Test Viability is selected. 

11 Live Cell Concentration – Indicates live cell concentration (in cells/mL) calculated using the live cell 
count and dilution factor. Displayed only if Test Viability is selected. 

12 Cell Concentration or Total Cell Concentration (Cells/mL) – Indicates cell concentration/total cell 
concentration calculated using the cell count/total cell count and dilution factor. Display of field toggles 
based on whether Test Viability is selected.  

13 Recount Icon         – Recounts cell sample using the previously taken images. 

14 Select Data File Icon         – Opens Windows File Explorer so users can indicate where count result data 
and images should be saved. 

15 Image Area – Displays image captured by the instrument. 

16 Save Data Button – Enables users to save the data in the indicated file. 

17 View Saved Data Button – Displays the data that would be saved. 

18 Calculate Concentration Adjustment Icon         – Activates Sample Adjustment tool used to calculate 
volume needed to adjust concentration; can only be used after a count is performed. 

19 Cell Size Analysis Icon         – Displays a histogram of cell diameter based on cells counted in the images 
using the Cell Size Analysis tool; can only be used after a count has been performed. 

20 Print Results Icon         – Prints results to selected printer. 

21 Export to Excel Icon         – Exports results to MS Excel worksheet. 

22 View Image – Toggles between images A and B via drop-down; zooms into fields of view 1-4. 

23 Counted – Displays graphic overlay highlighting counted cells. 

24 Count in View or Live/Dead Count in View – Displays total number of cells in the currently selected 
view. Display of field toggles based on whether Test Viability is selected.  

25 Manual Adjust or Live/Dead Manual Adjust – Enables users to manually adjust cell numbers by 
entering a count of cells in view. Display of field toggles based on whether Test Viability is selected.  

26 Help Icon          – Displays window providing users with access to online help contents and resources, 
instructions for submitting a support ticket, and Nexcelom contact information. 
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AVAILABLE MENUS 

The following menus are available in the Menu Bar displayed across the top of the Home screen. 

File Menu 
1 Load a previously saved image and display it. 

2 Load a previously saved image and count it. 

3 Choose a new data file. 

4 Open a previously saved data file. 

5 Save images the instrument has taken. 

6 Save counted images with the graphic overlay. 

7 Print results of the last count. 

8 Export results of the last count to MS Excel. 

9 Exit the software. 

 

Cell Type Menu 
1 Launch the Cell Type Wizard. 

2 Import/Export cell types. 

3 Create a new cell type. 

4 Edit the currently selected cell type. 

5 Delete the currently selected cell type. 

6 Set the current settings as default. 

 

Options Menu 

1 Edit the counting options. 

2 Edit the save options. 

3 Take new background image. 

4 Adjust brightfield exposure. 

5 View instrument details. 

 

Analysis Menu 

1 Open Sample Adjustment tool; also accessible 
via the         icon from the Home screen. 

2 Open Cell Size Analysis tool; also accessible 
via the         icon from the Home screen. 
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Help Menu 
 

1 The online help consists of instructions for operating Auto T4. 
2 Launches Nexcelom’s online resources page containing video tutorials, instructions on how to submit a 

support ticket including sample images, and access to Frequently Asked Questions/Application Notes 
(an internet connection is required when using this option). 

3 Displays version number of the Cellometer Auto T4 software currently installed. 

 

Note: Alternatively, clicking the Help icon          located in the bottom right corner of the Home screen also displays 
online help contents and resources, a link for submitting a Support ticket, and Nexcelom contact information. 
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IMPORT/EXPORT CELL TYPE SCREEN 

Cell Types define image analysis parameters used in cell sample detection. The Import/Export Cell Type Screen is 
used to import either standard cell types from the Nexcelom Cell Library installed with the Auto T4 software or 
custom cell types from an external network location. 

Once a library is selected, you can highlight cell types from the library (displayed in the pane on the left) and 
import them to appear in the Cell Types drop-down menu available on the Home screen (displayed in the pane on 
the right). Cell types selected to appear in the drop-down menu can also be exported to create a new library.  

 

1 Selects Nexcelom Cell Library to display Nexcelom cell types in the Cell Types in Cell Library pane. 

2 Selects a custom library to display available cell types in the Cell Types in Cell Library pane. If no 
library name is displayed, click the Browse button and navigate to an external cell type library.  

3 List of cell types in the currently selected Cell Library. 

4 Imports the highlighted cell type (from the left pane) into the drop-down menu (right pane). 

5 Imports all cell types (from the left pane) into the drop-down menu (right pane). 

6 Select to display drop-down menu options. 

7 List of cell types to be displayed in the drop-down menu. 

8 Deletes the highlighted cell type in the drop-down menu (displayed in the right pane). 

9 Clears all cell types in the drop-down menu (displayed in the right pane). 

10 Exports drop-down menu options (displayed in the right pane) to create a new Cell Library. 
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Cell Type Drop-down Defaults 

The Auto T4 displays several commonly known cell types that have been pre-selected to appear in the Cell Type 
drop-down menu available on the Home screen as initial defaults. These cell types are listed below: 

• HEK293 – Embryonic kidney cell line 

• Hela – Immortal cell line derived from cervical cancer cells 

• HT-29 – Human colorectal adenocarcinoma cell line 

• Initial Cell Type – Generic cell type with default settings 

• Jurkat – Immortal cell line of Human T lymphocytes 

• Large Size Cells – Generic cell type with a large cell diameter range 

• Medium Size Cells – Generic cell type with a medium cell diameter range 

• SF9 – Clonal isolate of Spodoptera frugiperda cells 

• Small Size Cells – Generic cell type with a small cell diameter range 

• Vero – Isolate of kidney epithelial cells 

Users can import additional cell types to appear in this drop-down as necessary from the Nexcelom Cell Library. 
See Nexcelom Cell Library on page 49 for a complete list of available cell types. 

Importing Cell Types 

Used to import cell types from the Nexcelom Cell Library or from external custom libraries. Individual cell types can 
then be selected to appear in the Cell Types drop-down menu displayed on the Home screen. 

FROM NEXCELOM CELL LIBRARY 

The Nexcelom Cell Library is available by default and if selected in the Import/Export Cell Type screen, available 
cell types are displayed in the Cell Types in Cell Library pane. 

1. In the Import from Library section of the Import/ 
Export Cell Type screen, ensure that the  
Nexcelom Cell Library radio button is selected. 

2. In the Cell Types in Cell Library pane (displayed on the 
left), highlight a cell type to be imported. 

3. Click Import Highlighted >> to import highlighted cell 
type to appear in the Cell Types in Drop-down Menu 
pane (displayed on the right). 

Note: Although Import All >> can be used to import 
all cell types, it is not recommended if the size of the 
cell library will make the Cell Types drop-down menu 
in the Home screen difficult to use.  
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FROM CUSTOM LIBRARIES 

1. In the Import from Library section of the Import/  
Export Cell Type screen, click the custom cell library 
radio button to choose a custom library (if available) 
or click Browse to navigate to folder containing a 
custom library and double-click on a library name to 
select it. This text box will appear as blank if a custom 
cell library has not yet been selected. 

2. Ensure that cell types from the selected library 
appear in the Cell Types in Cell Library pane. 

3. In the Cell Types in Cell Library pane (displayed on  
the left), highlight a cell type to be imported. 

4. Click Import Highlighted >> to import highlighted cell 
type to appear in the Cell Types in Drop-down Menu  
pane (displayed on the right). 

Note: If the custom library selected is of a manageable  
size for the Cell Types drop-down menu, Import All >>  
can be used to import all cell types from the library.  

Deleting Cell Types 

FROM HOME SCREEN 

1. Use the Cell Type drop-down menu to select the cell type  
to be deleted. 

2. Open the Cell Type Menu in the menu bar and select the 
Delete Cell Type option.  

3. Click Delete Cell Type. 

4. Click OK to confirm the deletion.  

5. Confirm cell type has been removed from Cell Type  
drop-down menu.  

Note: If cell type deleted was from the Nexcelom  
Cell Library, it can be re-imported if necessary.  
If cell type was from a custom library or created  
using the Auto T4, it may be permanently  
deleted unless cell type was exported and saved 
prior to deletion. 
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FROM IMPORT/EXPORT CELL TYPE SCREEN 

1. From the Home screen, open the Cell Type Menu in  
the menu bar and select the Import/Export… option. 

2. In the Cell Types in Drop-Down Menu pane (displayed 
on the right), highlight the cell type to be deleted. 

3. Click the Drop-down Menu Options checkbox to 
display additional options.  

4. Click the Delete Highlighted button. 

5. Click OK to confirm the deletion.  

6. Confirm cell type has been removed from Cell Type 
drop-down menu.  

Note: If cell type deleted was from the Nexcelom  
Cell Library, it can be re-imported if necessary. If cell 
type was from a custom library or created using the 
Auto T4, it may be permanently deleted unless cell 
type was exported and saved prior to deletion.  

 
 
 
 

Clearing Cell Types from Drop-down 

1. From the Home screen, open the Cell Type Menu in  
the menu bar and select the Import/Export… option.  

2. To clear all cell types from the Cell Types in  
Drop-down Menu pane (displayed on the right), select 
the Drop-down Menu Options check box.  

3. Click the Clear All button. 

4. Click OK to confirm the clearing of all cell types.  
Only the default Initial Cell Type will remain. 

Note: If cell types cleared were from the Nexcelom 
Cell Library, they can be re-imported if necessary.  
If cell types were from a custom library or created  
using the Auto T4, they may be permanently  
deleted unless cell types were exported and saved 
prior to deletion. 
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Exporting Cell Types to a Library 

Users can export cell types selected to appear in the  
Cell Type drop-down menu available on the Main  
Screen (displayed in the right pane) to create a custom  
Cell Library. 

1. From the Home screen, open the Cell Type Menu in  
the menu bar and select the Import/Export… option.  

2. To export cell types listed in the Cell Types in  
Drop-down Menu pane (displayed on the right), select 
the Drop-down Menu Options check box.  

3. Click the Export to Create Library button. 

4. Click OK to confirm save. 

5. Save file in designated folder. 

6. Click the Done button to return to the Setup screen. 
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Chapter 7. Sample Preparation 

PREPARING CELLOMETER CHAMBERED SLIDES 

1. For SD100 slides, remove the protective film from both sides of the slide. PD100 slides do not have this film. 

Note: It may be difficult to peel film from the slide. Some clients use tape to grab the film and then pull it off. 
Do not touch or write on the clear optical window areas of the slide.  

2. Place the Cellometer disposable chambered slide on a fresh Kimwipe. 

3. To prepare two samples at once, label the individual chambers (e.g., Chamber 1 and Chamber 2) in the white 
margin of each chamber. Take care to ensure the clear portion of the counting chamber is not touched. 

Note: Both chambers of the slide do not need to be loaded with the same sample. Two different 
samples can be used on a single slide.  

  

Top of Slide Bottom of Slide 
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LOADING SAMPLE INTO COUNTING CHAMBER 

Cellometer chambered slides consist of two independent counting chambers manufactured to a precisely-
controlled volume. A cell suspension of 20 µL is pipetted into a chamber through one of the induction ports. 

1. To prepare the sample for counting, invert the tube containing your sample 10 times, then pipette up and 
down 10 times. This will help evenly suspend cells. Do not shake sample as it may damage cell membranes. 

Note: If testing for cell viability (optional), stain the sample using a 1:1 ratio with 0.2% trypan blue (or other 
chosen viability stain) and mix the stain by pipetting up and down 10 times before performing Step 1, above.  

When preparing a sample to test for cell viability, ensure that the trypan blue stock concentration used is 0.2%. 
If stock concentration is 0.4%, it is recommended you dilute it with a balanced salt buffer (e.g., PBS) and filter 
diluted solution with a 0.2 micron filter before adding stain to your sample. 

2. Immediately transfer 20 µL of sample into a counting chamber by pipetting directly onto sample induction 
port. There are two counting chambers per slide; each chamber may be loaded with a different sample. 

3. Hold the loaded chamber in the white area and take care to stay away from the clear optical window. 

Load the counting chamber by touching the pipette tip to a sample introduction port and then slowly pipette the entire 20 µl 
sample at once. Capillary force automatically spreads the cell sample within the counting chamber. The chambers can hold 
separate samples as there is no mixing between the two chambers on the slide.  
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Chapter 8. Counting and Analysis Workflow  

This chapter presents basic workflow for counting cells/beads using the Auto T4, including best practices and tips. 
Sample images are provided as a reference for many common cell types. 

PERFORM CELL COUNTING 

1. Power ON the instrument and from the desktop of the Operating Computer, launch the Auto T4 software. 

2. Slowly Pipette 20 µl of the cell sample into counting chamber. See Preparing Cellometer Chambered Slides on 
page 31 for details. 

3. Load the chambered slide into the Auto T4 by inserting the counting chamber that contains the cell sample 
into Auto Sample Slot until touching the internal stop. The chamber inside the instrument will be counted. 

Note: If testing for cell viability, you must stain the sample before loading it into the slide chamber. 

4. Click the Display Image button.  

Note: When software is in Data Analysis Mode, the Display Image button will not be enabled. From the File 
menu, select Load Image for Display or Load Image and Count, then navigate to a previously saved image. 
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5. Slowly turn the Focus Knob on side of the instrument until good focus is achieved to ensure accurate counts. 
Live cells will have a bright center and a dark, crisp clearly defined edge as shown in the examples below. 

6. In the Setup area of the screen, choose the Cell Type from the drop-down list, enter a Sample ID and ensure 
the Dilution Factor is accurate for the sample. 

7. Click the Count button while the cell image is displayed.  

Note: When software is in Data Analysis Mode, the Count button will not be enabled. Click the Recount icon          
to re-analyze the captured image. 
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REVIEW COUNT RESULTS 

Once counting is complete, count results are displayed in the bottom left and right corners of the screen. Use the 
controls in the View Image area to view different areas of the counting chamber. Confirm data is accurate by 
clicking the Counted check box to view image using a graphic overlay outlining counted cells (e.g., green for 
counted cells and yellow for cells not counted because they were larger than the specified cell diameter).  

Note: When viewing counted cells, a red line will appear along edges of the Viewing Pane identifying the outer 
perimeter of the counting area. Any cells appearing on or outside of this red line are not counted. 

If testing for cell viability, select the Test Viability check box in the Setup area. Additional count results including 
Viability percentage are displayed. Click the Counted check box to view image using a graphic overlay outlining 
counted cells (e.g., green for live cells, red for dead cells and yellow for cells not counted because they were larger 
than the specified cell diameter).  
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Best Practices and Workflow Tips 

• The progress bar at the bottom of the software panel indicates counting is in progress. A numeric counter also 
displays updated cell counts. 

• Count results displayed in the bottom left corner of the screen represent the entire counting chamber and 
include Cell Count, Mean Diameter (micron) and Cell Concentration (cells/mL).  

• Count results displayed in the bottom right corner of the screen represent only the cells seen in the current 
view (i.e., displayed in the image area). Use the View Image controls to change the current view. 

• When the Test Viability check box in the Setup area is selected, additional count results are displayed 
including live and dead cell counts (i.e., Live/Dead Count, Total Cell Count, Live Cell Concentration, Total Cell 
Concentration). Viability percentage is calculated with live cell count as a percentage of total cell count, 
including live and dead cells. Viability testing can only be done with the addition of a Brightfield live/dead stain 
like trypan blue is added to the cell sample.  

• If cell counting optimization is required, you can customize cell type parameter settings using the Edit Cell 
Type option under the Cell Type drop-down menu. See Editing Cell Types on page 41 for details. 

Note: If you need help optimizing cell type parameter settings, contact Nexcelom Support for assistance at  
+1 (978) 327-5340 or email: support@nexcelom.com 

• After modifying cell type parameters, click the Recount Image icon         to recount cells in the image.  

• Data analysis features include Sample Adjustment and Cell Size Analysis tools. Based on the 
measured cell concentration, you can calculate the sample adjustment to achieve a target 
concentration or cell number. In addition, cell size data for the sample can be displayed  
using a histogram. See View Cell Size Analysis on page 37 and Calculate Sample Adjustment  
on page 38 for details. 

Saving Data and Images 

• To save count result data (as a .txt file) while viewing individual cell samples, click the Save Data button 
located at the bottom of the screen. See Manually Saving Data on page 51 for details. Once saved, you can 
click the View Saved Data button to view it. Use the New Data File option on the File Menu to change the 
selected data file. See Automatically Saving Data on page 52 to automatically save data after each count. 

• To save count result images (as .png and .jpg files) while viewing individual cell samples, use the Save Images 
or Save Counted Images options on the File Menu and navigate to a destination folder for saving image files. 
See Manually Saving Images on page 51 for details. All images captured for the sample during counting  
(i.e., A, B) will be saved as specified. See Automatically Saving Images on page 52 to automatically save images 
after each count. 

Printing Data 

Results can be printed after performing a count by clicking the Print icon         and selecting the name for a printer 
(e.g., may include applications such as Microsoft Print to PDF, Microsoft XPS Document Writer, OneNote (Desktop) 
and SnagIt 2021).  

Alternatively, data can be printed by selecting the Print Results option from the File Menu. 

mailto:support@nexcelom.com
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VIEW CELL SIZE ANALYSIS 

The Cell Size Analysis tool displays cell size data from count results by generating a histogram that enables users to 
optimize cell diameter parameters for the sample (e.g., to exclude debris or very large cells) and refine count data. 
By overlaying data from multiple samples into a single histogram, users can create an analysis of the change in cell 
diameter size over time. 

To use the Cell Size Analysis tool, you must first perform a count on either a live or saved image to display the 
diameter for each object found, as well as the mean diameter for cells in your sample (including dead cells if Test 
Viability was selected). Click on the Cell Size Analysis icon         to plot this information into a Cell Diameter 
Histogram illustrating cell size distribution in the sample. 

The tool plots cell size diameter distribution (Size Microns on the X axis) against the Percentage of Total Count 
(Percent on the Y axis), with the scales of each axis determined by count results. 

The coloring of bars reflects the nature of cells similar to how the graphic overlay is used to highlight counted cells 
(e.g., if testing for viability, green outlines live cells while red outlines dead cells). Other features of the histogram 
such as bar width, X /Y axis scales and number of bins used in the graph can be defined by clicking the Customize 
button. To view different aspects of the data, switch between the Data Table, Histogram and Gates buttons. 

In addition, you can perform the following tasks: 

1. To overlay data from multiple samples into a single histogram, click the Load button and navigate to additional 
diameter files. 

2. Click the Copy button to copy the graph to your Windows clipboard, the Print button to send it to a printer on 
the network or the Save button to save histogram data as a file. 

Alternatively, this tool can be activated by selecting the Cell Size Analysis option from the Analysis Menu. 
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CALCULATE SAMPLE ADJUSTMENT 

The Sample Adjustment tool assists you in calculating the adjustment necessary in order to achieve a specified 
target concentration or target number of cells in a tube. Before calculating this adjustment, you must first perform 
a count on either a live image or saved image to display the current cell count and concentration (or live/dead 
count, total cell count, viability %, live cell concentration and total cell concentration if Test Viability was selected). 

To calculate sample adjustment: 

1. Click on the Sample Adjustment icon         to launch the tool. 

2. Choose the concentration source to be used for calculating the 
adjustment (live, dead or total concentration) and click Continue. 

3. Enter the Original Sample Volume. The Total Cell Number in 
Sample value will be updated according to sample volume. 

4. Choose whether you want a Target Concentration (cells/mL) 
or a Target Number of Cells and enter the target concentration 
or cell count accordingly. 

5. Click Apply Change. In the Sample Adjustment field, a statement will appear indicating how to adjust the 
sample to reach the targeted concentration or cell count. 

6. Click the Print with Report check box to include adjustment results in the data report. 

 

 

 

 

 

 

 

 

 

 

 

Alternatively, this tool can be activated by selecting the Sample Adjustment option from the Analysis Menu. 
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REFERENCE OF CELL SAMPLE IMAGES 

Common cell type and bead sample images taken by the Auto T4 are presented for your reference below.  

Visit the Cellometer Auto T4 page on our website, click the Applications tab and scroll down to find additional cell 
type sample images.  

 
Cell Type Sample Images 

 

Bead Sample Images 

 

 

CD4 cells stained with Trypan Blue Jurkat Cells 

5 µm Beads                                        10 µm Beads                                          15 µm Beads                                          

https://www.nexcelom.com/nexcelom-products/automated-cell-counters/cellometer-auto-t4-automated-cell-counter/
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Chapter 9. Cell Types 

This chapter describes editing customizable cell type parameters to assist with declustering of clumpy cell lines. In 
addition, it lists all cell types included in the built-in Nexcelom Cell Library. 

EDITING CELL TYPES 

Cell types can be modified to meet your requirements using parameters available on the Cell Type Screen.  

Cell Type Screen 

 

1 Cell Type Name – Identifies name given to the cell type. 

2 Detailed Description – Contains cell type description. 

3 Save as New Cell Type – Saves changes to parameter settings as new cell type. 

4 Lock from Future Editing – Locks parameter settings so they cannot be modified. 

5 Minimum – Indicates minimum cell diameter to be counted. 
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6 Maximum – Indicates maximum cell diameter to be counted. 

7 Roundness – Indicates minimum roundness factor to be counted. 

8 Contrast Enhancement – Defines contrast enhancement for cells in relation to the background. 

9 Default Dilution Factor – Indicates if a default dilution factor should be used and enables entry of 
a specific value. 

10 Test Viability Default – Option indicating whether Test Viability is to be used as a default. 

11 Sensitivity – Sensitivity value for staining of cells to be included in count. 

12 Uniformity – Uniformity value for staining of cells to be included in count. 

13 Very Dim Dead Cells – Indicates whether to include cells that do not pick up the dye well. 

14 Decluster Edge Factor – Decluster setting identifying how well cell edges are defined. 

15 Decluster Th Factor – Decluster intensity setting to be used comparing cell signals to background. 

16 Do Not Decluster Clumps – Indicates whether decluster enhancement settings are to be used. 

17 Use Template for Printing – Indicates whether to use a print template. 

18 Set Default – Allows users to select a default print template. 

19 Browse – Allows users to browse for an existing print template. 

20 Edit – Allows users to edit an existing print template. 

21 New – Allows users to create a new print template. 

22 Use Template for Data.txt – Indicates whether to set a data template. 

23 Set Default – Allows users to select a default data template. 

24 Browse – Allows users to browse for an existing data template. 

25 Edit – Allows users to edit existing data template. 

26 New – Allows users to create a new data template. 

27 Save button – Saves changes to parameter settings. 

28 Print button – Prints cell type parameters. 

29 Cancel button – Closes window without saving changes to parameter settings. 

Note: Cell types imported from the Nexcelom Cell Library cannot be modified. However, Nexcelom cell types can 
be saved as a new cell type (i.e., by selecting the Save as a New Cell Type check box), renamed and then modified 
to meet your requirements. 
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Adjusting Cell Diameter Parameters 

For each cell type, Cell Diameter Minimum/Maximum (in microns) parameter settings indicate the size of cells to 
be included in the count.  

To determine if cell diameter parameters are set up properly, use the Counted check box in the Home screen to 
display a graphical overlay outlining counted cells (e.g., green for counted cells and yellow for cells not counted as 
they are larger than the specified cell diameter). For example, the figure below shows counted cells for the same 
HT-29 image using different cell size parameter settings. 

HT-29 cell count results were analyzed using different cell diameter parameter settings. Figure (a) – "Cell Diameter 
Minimum" size is too large. Cells smaller than 15 µm are not counted, as indicated by missing outlines. Figure (b) – "Cell 
Diameter Maximum" is too small. Cells larger than 16 µm are not counted, as indicated by the yellow outlines. Figure (c) – 

Both "Cell Diameter Minimum" and "Cell Diameter Maximum" are set up properly to include all cells. Figures (d), (e) and (f) 
are respective cell size histograms for (a), (b), and (c). They are also used to establish cell size parameter settings. 
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Adjusting Trypan Blue Viability Parameters 

Using default settings for Trypan Blue Viability Parameters provides the fastest counting speed for standard cell 
types stained a solid dark blue by trypan blue. As some cell types exhibit different morphology after being stained, 
it may be necessary to adjust parameters for accurate detection of the trypan blue population as indicated below.  

 

Weak blue dead cells  

To pick up weak blue dead cells, select the  
Very Dim Dead Cells check box and slowly increase 
the Enhancement value to further refine the division 
between the background and cells with low contrast  
(i.e., no defined edges). Suggested Enhancement value 
is 0.60; available range is 0.04 (stained cells have 
medium contrast to background) to 0.90 (stained cells 
have very low contrast to background). 

Note: It is a best practice to use the Very Dim Dead Cells 
check box in conjunction with other Trypan Blue Viability 
Parameters (such as Enhancement, Sensitivity or  
Uniformity values) to avoid overcounting. 

 
 
 
Dead cells with light blue centers  

To pick up dead cells with light blue centers, slowly 
increase the Uniformity value. Suggested value is 150; 
available range is 100 (stained cells are all uniform in 
color) to 255 (stained cells have non-uniform dark and  
light areas). 

In addition, slowly increase the Sensitivity value to  
further refine image clarity. Suggested value is 1.0;  
available range is .10 (stained cells are all dark) to 5.0 
(stained cells are a mix of dark and light images). 

Variations in sensitivity values used to pick up dead cells 
with light blue centers are presented on the next page.  

 

 



 Chapter 9. Cell Types 

8001009 Cellometer® Auto T4 User Manual Rev C  45 

 

CHO cell count results were analyzed using different "Sensitivity" settings. Figure (a) shows CHO cell image while figures (b) – 
(e) show an incremental increase in “Sensitivity” parameter from 1 to 4, respectively. Green outlines indicate live cells while 
red outlines indicate dead cells. Both live/dead cell counts in figure (e) agree with visual observation of image in (a). 

 

Adjusting Decluster Parameters for Clumpy Cells 

The Decluster Edge Factor and Decluster Th Factor 
(Decluster Threshold Factor) parameters may be used to 
separate clumpy cells (i.e., connected cells for which it is 
difficult to distinguish clearly defined edges). Default 
values for these parameters are 0.5 and 1.0, respectively.  

For the majority of cell types, the default values for  
these parameters are adequate to separate clumpy cells. 
However, some cell types (such as MCF7 and PC12) 
contain cells having dim boundaries within the clump. In 
these cases, decluster parameters can be modified to 
visually separate clumpy cells in the captured images.  

To define edges of clumpy cells in more detail, slowly 
increase the Decluster Edge Factor and Decluster Th  
Factor values. These parameters work in conjunction with 
the Contrast Enhancement value. 
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SAMPLE CLUMPY MCF7 CELLS 

 In the sample below, clumpy MCF7 cells are analyzed using both default and modified Decluster Edge Factor and  
Decluster Th Factor parameter settings. 

 

MCF7 cell count results were analyzed using different "Decluster" parameter settings. Figure (a) shows default decluster 
settings (cells within clumps are not fully separated), resulting in MCF7 concentration of 6.5 x 105 cell/mL. When 
modified declustering settings are used as shown in figure b, cells within the clumps are separated resulting in MCF7 
concentration of 8.3 x 105 cell/mL. 

DISABLING DECLUSTER FOR SMALL CELLS 

Examples of small size cells are mouse splenocytes, 
lymphocytes, thymocytes, and PBMCs. Their cell diameters 
are typically less than 7 µm.  

The Auto T4’s focus position for really small cells may 
influence cell counting when the Decluster feature is 
enabled (i.e., the Do not Decluster Clumps check box 
is not selected). This feature works in conjunction with the 
Contrast Enhancement value. 

For the purpose of the following example, cell type  
parameter settings as shown in this screen were used  
to count mouse thymocyte cells in low concentration 
(i.e., cell counts less than 1300). Images explaining  
count results for various scenarios are presented. 

 

Edge Factor = 0.5 
Th Factor = 1.0 
 

Edge Factor = 0.7 
Th Factor = 0.8 
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Mouse thymocyte count results using the parameter settings identified in the screen above are shown in figure (a) 
with the Decluster feature activated (i.e., Do not Decluster Clumps check box is not selected) and in figure (b) 
without the Decluster feature. The green outlines indicate counted cells. When declustering is turned off by 
selecting the Do not Decluster Clumps check box, more cells are counted.  

 

Mouse thymocyte count results, (a) with Decluster activated and (b) without Decluster. 

However, some samples contain clumpy cells, as shown in figure (a) below. Other samples have a very high cell 
concentration as shown in figure (b). For these samples, the Decluster feature is activated (i.e., Do not Decluster 
Clumps check box is not selected) and the Contrast Enhancement value was reduced (to a value of .70). 

 

Cell type parameters for high concentration or clumpy small-sized cells. 
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CREATING NEW CELL TYPES 

Using Cell Type Wizard 
1. Open the Cell Type menu from the menu bar and select the  

Cell Type Wizard… option. 

2. Select the source of new cell parameters: Live Image or Saved Image 

3. Click Continue. 

Note: Live Image is used when Auto T4 is loaded with a counting chamber 
containing cells. Saved Image uses saved Auto T4 cell images. 

4. Input a new Cell Type Name (replacing default entry of new cell type). 

5. Process cell images to establish cell type parameters and click Save. 

6. Perform a visual inspection to confirm accuracy of parameter settings. 

7. Click the Count button.  

8. Using the View Image control, click through views 1 to 4. 

9. Visually inspect cell images and enable Counted check box to display  
overlay of green, red and yellow outlines. 

10. Adjust cell type parameter settings and recount cells in the sample as necessary. See Editing Cell Types on 
page 41 for details. 

Creating Cell Type Manually 
1. Select a cell type similar to the cells being used or choose the Initial Cell Type option from the drop-down. 

2. Open the Cell Type menu from the menu bar and select the Edit Cell Type… option. 

3. Check the Save as New Cell Type check box. 

4. Modify the cell type name (by adding your initials or specify defining characteristics). 

5. Process cell images to establish cell type parameters and click Save. 

6. Click Count button.  

7. Using the View Image control, click through views 1 to 4. 

8. Visually inspect cell images and enable Counted check box to display overlay of green, red and yellow outlines. 

9. Adjust cell type parameter settings and recount cells in the sample as necessary. See Editing Cell Types on 
page 41 for details. 
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NEXCELOM CELL LIBRARY 

The complete collection of cell types available for import from the Nexcelom Cell Library is listed below.  

 
2372 
2H3 
3T3 
786-O 
A204 
A2058 
A3R5 
A549 
Alex cell 
AR40 
ARPE-19 
Astrocyte 
aTC6 
B16 
BHK 
BT 
BXPC3 
C2C12 
C6 
C6-36 
CALU6 
CCR5 
CEF 
CGN 
CHO-1 
CL-1 
Colo205 
Cos7 
CRL-1863 
CT-26 
CT-26-B7 
CT-26-CEA 
CT26-CEA-B7 
D1.1 
DC145 
Dictyoslelium 
DLD 
D-MEL 
DU 

DU145 
DU145 G37 
EL4 
Fao  
Fibroblast_human 
Fibroblast_human_high density 
Fibroblast_pig 
FRhK4 
FU5AH 
G37 
GHOST 
GM cell 
GRANTA 
H157 
H358 
H42E 
H520 
H647 
H9 
HASMC 
HBL-2 
HC9 
HCE4 
HCT15 
HDF 
HEC 
HEK293 
HEK293T 
Hela 
High 5 
HL-60 
HMN 
HNPM 
HOS 
HOS MNNG 
HPAF II 
HT-1080 
HT-29 
HUT78 

HUVEC 
Hybridoma 
I9.2 
Initial Cell Type 
Ink-4A 
INS 
Jurkat 
K1 
K562 
K9 fibroblast 
KAT4 
KR158 
KT1 
KT2 
KU812 
L cell 
L1210 
L929 
large size cells 
LCL  
LLC-PK1 
Lncap 
Lymphoma 
M19 
Macrophages 
MAGIC 
Malme 3M 
Mast 
MC32A 
MC32A-B7 
MC-38 
MC-38-B7 
MCF-10A 
MCF-10A4 
MCF7 clumpy 
MCF7 non-clumpy 
MCF7_clumpy 
MDA-231 
MDA-MB-231 

MDA-MB-435 
MDA-MB-468 
MDBK 
medium size cells 
MEF 
Melan A 
Melan-3m 
Melanocyte 
Melanoma 
Mel-STR 
Mel-STV 
MES-SA 
MG63 
MM1S 
MMS 
MNT1 
Mouse ES feeder cell  
MRC5 
MSB1 
MTA-9 
MV411 
N59 
NCI-460 
NCI-H929 
ND468 
new cell type 
NIH 3T3 
NM4A 
NM4A4 
OCIM1 
OVCAR 
P19 
PA-317 
PC 
PC-12 
PC3 
PDAC 
PLHC 
QNR-K22 

Raji 
Ramos 
RAW 
RCC45 
RCS 
RD 
RD cell 
ReN 
RPMI7951 
RPMI-7951 
SaOS 
SF9 
SK28 
SK-MEL-28 
SKOV3 
small size cells 
SNU475 
SW48 
SW480 
SW620 
TH1 
THP 
Til-T 
TME-7 
Tn5 
TS 
U118 
U266 
U2OS 
U87 
U937 
UACC 257 
V12 
V529 
Vero 
WIDR 
Wil2S 

  

If you would like help creating a new cell type or customizing cell type parameters for a sample, send saved raw 
images to support@nexcelom.com and we will optimize a custom cell type for you. See Saving Data and Images on 
page 51 for details on how to save the information that Nexcelom will need. 

 

mailto:support@nexcelom.com
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Chapter 10. Data Management 

This chapter describes how to save count result data and image files, export them to an Excel spreadsheet and 
how to load previously-saved data and images back into the Auto T4 for reanalysis.  

SAVING DATA AND IMAGES 

Manually Saving Data 

1. Perform a cell count on the sample currently being viewed.  

2. Click the Select Data File icon         in the bottom left corner of the screen to navigate to a folder on the 
Operating Computer or network where the data file is to be saved. 

3. Enter a name for the data file (e.g., data) and click Open to return to the Home screen. 

4. To save data (i.e., cell count and parameter settings associated with the count), click the Save Data button.  

5. Click OK in response to the Save Data confirmation prompt. Data is saved to a text (.txt) file. 

Note: Count results are saved by default to a single .txt file in which rows (logged with a date/time stamp and 
Sample ID) are appended each time data is saved. Rows include key parameter settings used for the count. 

6. To view your data, click the View Saved Data button or navigate to the folder and open the data file. 

Alternatively, you can use the New Data File and Open Data File options available on the File Menu to create a data 
file and view saved data. 

Manually Saving Images 

1. Perform a cell count on the sample currently being viewed.  

2. Open the File Menu and select either the Save Images or Save Counted Images option. Choosing Save Counted 
Images includes the graphic overlays that were created during the counting process. 

3. Navigate to a folder on the Operating Computer or network where image files are to be saved. 

4. Enter a name for the images file folder to be created and click Save to return to the Home screen. 

5. Click OK in response to the Save Images confirmation prompt. 

  



 Chapter 10. Data Management 

8001009 Cellometer® Auto T4 User Manual Rev C  52 

Automatically Saving Data 

1. Open the Options Menu and select the Save Options… option.  

2. Click the Auto Save data.txt check box to select it. 

3. If you want to create a new data text file each time cells are counted, click the Create new data.txt with each 
sample check box to select it. Keep in mind that selecting this option may result in a large volume of files. 

Note: If this is option is not selected, a new row containing a date/time stamp and key parameter settings will 
be appended to the existing data file each time cells are counted.  

4. Click the Set Folder button to navigate to a folder on the Operating Computer or network where data files are 
to be saved. It is recommended that data files be saved to a folder on the desktop or USB drive. 

5. Enter a file name (e.g., data) and click Open to return to the Home screen.  

Once auto saving of data is set up, results will be saved to the specified folder and file each time cells are counted.  

Automatically Saving Images 

1. Open the Options Menu and select the Save Options… option.  

2. Click the Auto Save Sample Image check box to select it. 

3. Indicate whether you want to Save Raw Images (saved as .png files; images can be loaded back into Auto T4 
for reanalysis), Save JPG Copies (images cannot be loaded back into Auto T4; use for adding to presentations 
or reports) or Save Counted Images (also saved as .jpg files; images include graphic overlays of outlined cells).  

Note: Nexcelom Support will require raw images when requesting assistance with optimization of cell type 
parameters or troubleshooting. 

4. Click the Set Folder button to navigate to a folder on the Operating Computer or network where image files 
are to be saved. It is recommended that image files be saved to a folder on the desktop. 

5. Enter a file name (e.g., SampleImage) and click Open to return to the Home screen. 

Once auto saving of images is set up, files will be saved to the specified folder each time cells are counted.  
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LOADING DATA AND IMAGES 

Loading Data Files 

1. Open the File Menu and select the Open Data File option. 

2. Navigate to a folder on the Operating Computer or network where data files are stored and select data file to 
be loaded. Data file selected should contain data previously saved from the instrument in a .csv format. 

3. Click Open to load the data and return to the Home screen. 

4. Click View Saved Data. 

Loading Image Files 

1. Open the File Menu and select the Load Image for Display option (to load image for viewing) or Load Image 
and Count option (to load image and perform a count). 

2. Select the image file to load and click Open to return to the Home screen. 

Note: If the Intelligent File Load check box in the Counting Options screen (available on the Options Menu) is 
selected, you will only need to select a file that ends in “-A” as the remaining image will load automatically. 
Otherwise, the File Explorer window will open again for you to select the associated “-B” image. 

In addition, if the Load Image for Display option was selected, only saved images will be displayed for viewing. 
When software is in Data Analysis Mode, the Count button will not be enabled. Click the Recount icon         to  
re-analyze the captured image. 
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EXPORTING DATA AND IMAGES 

Data and images can be exported by clicking the Export to Excel icon         after performing a cell count.  
 

1. To Export Count Details to Excel, choose items to be included in the export (e.g., images with data file, JPG 
image copies with file, counted images with file) and indicate whether to open Excel when Done. Click 
Continue. When prompted, navigate to a folder on the Operating Computer or network where data files are 
stored, enter a file name and click Save. Data is saved as an .xlsx file and associated images (if selected for 
export) will be stored in a folder using the same name. 

2. To Save Counting Results to File, click the Change File button to navigate to a folder on the Operating 
Computer or network where data files are stored, enter a file name and click Open. Click Continue to save the 
file and return to the Home screen. Data is saved as an .xlsx file. 

Alternatively, you can use the Export Results to Excel option available on the File Menu to export data and images. 
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Chapter 11. Cleaning, Maintenance and Storage 

Keeping the Auto T4 and its operative area clean between runs, during use and post runs is a best practice and 
prevents contamination. Caring for the instrument and its consumables is also a best practice.  

 

CAUTION: Always power OFF the instrument before cleaning as damage to the machine could occur.  

CAUTION: Allow for flammable agents used for cleaning or disinfecting (or as solvents for adhesives) 
to completely evaporate before powering ON the instrument.  

 

CLEANING  

The instrument and any cords/cables can be wiped down using a 70% Isopropyl (IPA) solution. Repeat until the soil 
is no longer visible. Finish with a fiber optic lint-free wipe (e.g., Kimwipes). 

1. Dampen a fiber optic lint-free wipe with IPA. 
2. Use the wipe to rub lightly on the outside of the instrument until it is visibly clean.  
3. Wait for the cleaning agent to evaporate before powering the instrument ON.  

Should something break or be spilled inside the device, power OFF the instrument and contact Nexcelom Support 
at +1 (978) 327-5340 or via email: support@nexcelom.com 

ROUTINE MAINTENANCE 

No one other than Nexcelom-authorized personnel may service inside the protective instrument cover of the  
Auto T4. Contact Nexcelom Support or an authorized service representative to address any changes in instrument 
output or performance.  

 

WARNING: Do not remove the instrument cover due to an electric shock hazard. Contact Nexcelom 
Support for assistance. 

Contacting Nexcelom Support 

All technical questions regarding maintenance should be directed to Nexcelom Support at +1 (978) 327-5340 or via 
email: support@nexcelom.com 

  

mailto:support@nexcelom.com
mailto:support@nexcelom.com
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Preventive Inspection and Maintenance 

Regular preventive inspections should be carried out to reduce safety concerns of the instrument due to aging, 
normal wear and tear, etc. The manufacturer assumes no responsibility for improper changes or repairs carried 
out on the instrument or its accessories by unauthorized persons. The warranty will immediately become void 
should an unauthorized personnel attempt to in any way repair or modify the instrument.  

Contact Nexcelom Support to schedule all preventive maintenance needs and address any functionality concerns 
at +1 (978) 327-5340 or via email: support@nexcelom.com 

STORAGE 

When preparing the instrument for storage: 

• Always thoroughly clean the instrument, cables and any of the accessories or consumables before storage.  
• Check for any damage and if possible, re-package the Instrument and Operating Computer.  
• Ensure that storage temperature and spatial requirements are met (see Site Preparation on page 14).  
• DO NOT put anything heavier than ≥25 lbs. on the instrument or the box in which it is stored. 

Store the cables neatly, checking for any signs of damage or wear frequently and immediately 
before/after use. Do not allow the cables to become kinked or tangled. Do not set heavy objects on any 
of the accessories or consumables.  

Always store beads and reagents according to their information for use documentation. 

 

 

mailto:support@nexcelom.com
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Chapter 12. Troubleshooting and FAQs 

This chapter lists troubleshooting steps for resolving potential issues, common software error messages and 
Frequently Asked Questions (FAQs).  

TROUBLESHOOTING AND ERROR MESSAGES 

Particles appear in the background/background is too dark 

• Take a new background image by following the steps presented in Taking a Background Image on page 18. 

Instrument cannot be powered on 

• Check to ensure the Power Cord that was provided with the instrument is being used. 
• Check Power Cord to confirm it is not kinked or tangled.  
• Check that Power Cord is plugged in properly to both the outlet and the instrument.  
• Check that Power Switch on instrument is set to the ON position. 

Instrument displays software error messages 

The Auto T4 software has built-in error messaging when functionality is operating improperly. A few common error 
messages are listed below: 

• No instrument detected. 
• Background was saved, but …. Dim XXX counts 
• Error setting up Preview 
• Could not read GPIO Values 
• Running software in data analysis mode. 

IF ERROR REQUIRES REBOOTING THE INSTRUMENT 

If error encountered cannot easily be resolved, follow the steps listed below to reboot the Auto T4 system and 
repeat the task to be performed. 

1. Close out of the software. 
2. Shut down and restart the Operating Computer. 
3. Power OFF the instrument. 
4. After the Operating Computer has restarted, power ON the instrument. 
5. Restart the Auto T4 software. 

If the problem persists, contact Nexcelom Support for assistance at +1 (978) 327-5340 or email: 
support@nexcelom.com 
  

mailto:support@nexcelom.com
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IF ERROR REQUIRES CREATING A SUPPORT TICKET 

If error encountered that cannot be resolved and/or the problem persists after rebooting the Auto T4 system, 
perform the following steps before creating a Support ticket: 

1. Record the error message. 
2. Record the sequence of events that caused the error, if possible. 
3. Close the error message window.  

This information may be helpful to Nexcelom Support when troubleshooting the issue. Contact Nexcelom Support 
for assistance at +1 (978) 327-5340 or email: support@nexcelom.com 

FREQUENTLY ASKED QUESTIONS 

Can SD025 and SD300 slides be used on the Auto T4?  

No, the Auto T4 is designed to be used only with the SD100 slides. 

How do I upgrade to the newest version of the software? 

Contact support@nexcelom.com with the serial number of the instrument to request an upgrade. 

The Power Cord or USB Connector Cable for the instrument has been lost. 

Contact support@nexcelom.com with the serial number of the instrument to request replacements. 

The cell type needed does not appear in the Cell Type drop-down. 

Cell types can be imported from either the Nexcelom Cell Library or from custom libraries stored in external 
network locations. See Importing Cell Types on page 26 for instructions on how to import a cell library and 
populate the Cell Type drop-down menu with selected cell types. 

When testing for cell viability, count results are lower than expected. 

When preparing a sample to test for cell viability, ensure that the trypan blue stock concentration used is 0.2%.  
If stock concentration is 0.4%, it is recommended you dilute it with a balanced salt buffer (e.g., PBS) and filter 
diluted solution with a 0.2 micron filter before adding stain to your sample. Using trypan blue in a concentration 
higher than 0.2% will make the cells more difficult to detect and may result in counting inaccuracies. 

 

 

mailto:support@nexcelom.com
mailto:support@nexcelom.com
mailto:support@nexcelom.com
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Chapter 13. Nexcelom Support 

This chapter presents the scope of available Nexcelom Support services and provides global contact information.  

SCOPE OF SUPPORT SERVICES 

Nexcelom is dedicated to providing our customers with outstanding support including the following services: 

• Online and in-lab customer training 
• Creation of new cell types 
• Optimization of counting parameters 
• Troubleshooting via telephone 
• Periodic safety checks and functional evaluations (offered as part of a separate maintenance contract) 

To explore Nexcelom Support, training and resources available online or in your area, visit our website at 
Nexcelom.com/training-and-support/ or contact Nexcelom Support. 

CONTACTING SUPPORT 

If there is a technical problem with your instrument or software, contact Nexcelom Support. 

Nexcelom Corporate Headquarters 

Nexcelom Bioscience 
360 Merrimack Street, Suite 200 
Lawrence, Massachusetts 01843 
USA 

Phone: (978) 327-5340 
Fax: (978) 327-5341 

support@nexcelom.com 

 

  

San Diego Office 

Nexcelom Bioscience LLC 
11100 Roselle Street, Suite B 
San Diego, California 92121 
USA 

Phone: (978) 327-5340 
Fax: (978) 327-5341 

support@nexcelom.com 

Manchester Office 

Nexcelom Bioscience Ltd 
Unit 5, Rutherford House 
Pencroft Way 
Manchester Science Park 
Manchester 
M15 6SZ 
United Kingdom 

Phone: +44 (0) 161 232 4593 

support@nexcelom.com 

Shanghai Office 

Nexcelom Bioscience Instruments 
(Shanghai) Co. Ltd 
Unit 4-E, North Building 
No.2966, Jinke Rd, 
Pudong New District, Shanghai 
201203 
China 

Phone: (+86) 21 5886 0038 

support@nexcelom.com.cn 

 

https://www.nexcelom.com/training-and-support/
mailto:support@nexcelom.com
mailto:support@nexcelom.com
mailto:support@nexcelom.com
mailto:support@nexcelom.com.cn
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Appendix A. Consumables 

This appendix presents Nexcelom consumables designed specifically for the Auto T4 such as disposable chambered 
slides, beads and reagents. Catalog numbers are listed for all available sizes.  

DISPOSABLE CHAMBERED SLIDES 

Cellometer Cell Counting Chambered Slides are compatible with all Cellometer Systems. Each all-plastic, disposable 
slide contains two sample counting chambers with a precisely-controlled height. The fixed 20µl sample size allows 
for simple, automated calculation of cell concentration following imaging and counting. Image-based counting with 
disposable counting chambers offers several key advantages: 

• No potential clogging 
• Ideal for fragile samples, such as hepatocytes 
• No washing 
• No potential cross-contamination 

Catalog # Description Size Unit Image 

CHT4-PD100-002 

Standard chamber thickness. 
Packed in microscope slide 
boxes. Individually QC-
Checked. 4-year expiration. 

Box of 100 slides for 
200 counts 1 Box 

 

CHT4-PD100-003 

Standard chamber thickness. 
Packed in microscope slide 
boxes. Individually QC-
Checked. 4-year expiration.  

Case of 500 slides for 
1,000 counts  
(10 individual boxes) 

1 Case 

 

CHT4-PD100-303 

Standard chamber thickness. 
Packed in microscope slide 
boxes. Individually QC-
Checked. 4-year expiration. 

Case of 1,500 slides for 
3,000 counts  
(30 individual boxes) 

3 Cases 

 

CHT4-PD100-503 

Standard chamber thickness. 
Packed in microscope slide 
boxes. Individually QC-
Checked. 4-year expiration.  

Case of 2,500 slides for 
5,000 counts  
(50 individual boxes) 

5 Cases 
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Catalog # Description Size Unit Image 

CHT4-SD100-002 
Standard chamber thickness. 
Packed with protective film.  
1-year expiration. 

Box of 75 slides  
Good for 150 counts 1 Box 

 

CHT4-SD100-014 
Standard chamber thickness. 
Packed with protective film.  
1-year expiration. 

Case of 900 slides  
Good for 1,800 counts 1 Case 

 

CHT4-SD100-314 
Standard chamber thickness. 
Packed with protective film.  
1-year expiration. 

Case of 2,700 slides 
Good for 5,400 counts 3 Cases 

 

CHT4-SD100-514 
Standard chamber thickness. 
Packed with protective film.  
1-year expiration. 

Case of 4,500 slides 
Good for 9,000 counts 5 Cases 

 
 

Visit the Nexcelom-products/cellometer-disposable-counting-chambers page on our website for an up-to-date list 
and to purchase Cellometer Counting Chambered slides directly from Nexcelom Bioscience. 

  

https://www.nexcelom.com/nexcelom-products/cellometer-disposable-counting-chambers/
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BEADS AND REAGENTS 

Nexcelom Bioscience provides a wide variety of beads and reagents for all of your analysis needs. 

Catalog # Description Size Unit Image 

B05-02-050 
5 µm polystyrene bead in Trypan Blue 
Solution. Good for 200 counts 

1 mL 4 Vials 

 

B10-02-020 
10 µm polystyrene bead in Trypan Blue 
Solution. Good for 200 counts 

1 mL 4 Vials 

 

B15-02-010 
15 µm Polystyrene bead in Trypan Blue 
Solution. Good for 200 counts 

1 mL 4 Vials 

 
 

Visit the Nexcelom-products/reagents page on our website for an up-to-date list and to purchase reagents for use 
with Cellometer instruments directly from Nexcelom Bioscience. 

 

 
  

https://www.nexcelom.com/nexcelom-products/reagents/
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Appendix B. Declaration of Conformity 

According to ES3043-1 

Manufacturer: Nexcelom Bioscience LLC 
Address: 360 Merrimack Street, Suite 200, Lawrence MA 01843 USA 
Product Name: Cellometer Auto T4 High-Speed Cell Counter Model Number: Cellometer Auto T4 
 

Conforms to the appropriate country standards and governing regulations listed below. We, as the manufacturer, 
are fully responsible for the design and production of the above-mentioned equipment. 

Safety: 

• EN 61010-1:2010 Safety requirements for electrical equipment for measurement, control, and laboratory use 

EMC: 

• EN 55032:2012/AC:2013 Class A ITE emissions requirements (EU) 
• ICES-003 Issue 6 Class A Digital Apparatus emissions requirements (Canada) 
• CFR 47 FCC Part 15 Subpart B Class A emissions requirements (USA) 
• AS/NZS CISPR 32:2013 Class A ITE emissions requirements (Australia) 
• VCCI-CISPR 32:2016 Class A ITE emissions requirements (Japan) 
• EN 61000-3-2:2014 Limits for harmonic current emissions (equipment input current up to and including 16A 

per phase) 
• EN 61000-3-3:2013 Limitation of voltage fluctuations and flicker in low voltage supply systems for equipment 

with rated current up to and including 16 A 
• EN61326-1:2013 EMC requirements for Electrical equipment for measurement, control and laboratory use - 

General Use 

Supplementary Information: 

The product herewith complies with the requirements of the Low Voltage Equipment Directive 2014/35/EU and 
the EMC Directive 2014/30/EU and carries the CE marking accordingly. 

This product was tested in a typical configuration. 

This device complies with Part 15 of the FCC rules. Operation is subject to the following two conditions: 1) this 
device may not cause harmful interference, and 2) this device must accept any interference received, including 
interference that may cause undesired operation. 

 

Matthew Bularzik 
Head of Quality 
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Appendix C. Warranty and License Details  

This appendix presents Warranty Information for Cellometer instruments, Nexcelom’s Limitation of Liability 
(Hardware and Software) statement, and Terms and Conditions related to the use of Cellometer software and 
related documentation. In addition, it includes a definition of Nexcelom’s Proprietary Information. 

WARRANTY INFORMATION 

Nexcelom warrants that Cellometer instrumentation products shall, for a period of twelve (12) months from the 
date of purchase, be free of any defect in material and workmanship. The sole obligation of this warranty shall be 
to either repair or replace at our expense the product, at manufacturer’s option. The original sales receipt must be 
supplied for warranty repair. Products which have been subjected to abuse, misuse, vandalism, accident, 
alteration, neglect, unauthorized repair or improper installation will not be covered by warranty. 

Instruments must be handled and packaged correctly when shipping to other locations. Contact Nexcelom for 
additional information and to order packaging materials. 

Any product being returned is to be properly disinfected and packaged (in original packing if possible). Damage 
sustained in shipping due to improper packing will not be covered by warranty. 

TERMS AND CONDITIONS 

The Nexcelom Bioscience LLC – Terms and Conditions of Sale license agreement states the terms and conditions 
upon which Nexcelom Bioscience offers to license to you the software together with all related documentation. 
The Software is licensed to you for use only in conjunction with Nexcelom’s family of products. 

In addition, the original Cellometer software and any software upgrades installed on your Cellometer system by 
authorized representatives of Nexcelom Bioscience LLC is protected. You may not tamper with this software 
(including unauthorized upgrades), disclose it to third parties or use it for any purpose other than running your 
Cellometer system. Nexcelom Bioscience LLC does not grant you any other rights to use or disclose the original 
Cellometer software or upgrades, and any further uses will be prosecuted by Nexcelom Bioscience LLC to the 
maximum extent possible by law. Any other use of Cellometer software or upgrades is explicitly prohibited. In 
addition, you may not disclose Cellometer software, upgrades, or any of its features and benefits to a third party. 

Nexcelom Proprietary Information 

Cellometer products have been developed by Nexcelom Bioscience LLC and include certain intellectual property of 
Nexcelom, including without limitation, software, samples, schematics, specifications, manuals, designs, and other 
technical, business, trade secret, proprietary and confidential information provided to Buyer by Nexcelom 
(“Nexcelom Proprietary Information”).  
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Buyer is granted a non-exclusive right and license to use the Nexcelom Proprietary Information solely: (a) as 
incorporated into, and in conjunction with, the products, (b) in conformance with the specifications, and (c) for 
Buyer’s internal use.  

Buyer may not: (i) assign, sublicense, transfer, lease, rent or distribute any of its rights in the Nexcelom Proprietary 
Information; (ii) port, translate, localize or create derivative works based upon the Nexcelom Proprietary 
Information in any manner; (iii) reverse assemble, decompile, reverse engineer, translate or otherwise attempt to 
derive or obtain the source code, the underlying ideas, algorithms, structure or organization of the Nexcelom 
Proprietary Information; (iv) use the Nexcelom Proprietary Information for the benefit of any third party including 
as part of any service bureau, time sharing or third party training arrangement; or (v) publish any benchmark 
testing results on any product or the Nexcelom Proprietary Information without Nexcelom’s written consent.  

Nexcelom Bioscience LLC retains all ownership rights in the Nexcelom Proprietary Information and, other than 
limited license set forth in this section, Buyer shall have no right in or to the Nexcelom Proprietary Information.  

Buyer will not disclose the Nexcelom Proprietary Information to any third party or use it in any manner outside the 
scope of the license including: (1) developing, designing, manufacturing, engineering, reverse engineering, 
refurbishing, selling or offering for sale items, parts or components of items, derivatives of or equivalents, or  
(2) assisting any third party in any manner to perform such activity.  

Buyer shall use reasonable care to protect the Nexcelom Proprietary Information, and in no event less than the 
care Buyer uses to protect its own like information.  

LIMITATION OF LIABILITY (HARDWARE AND SOFTWARE) 

Cellometer® automated cell counting instruments, software and consumables are intended for research use only. 

In no event shall Nexcelom be liable for any damages whatsoever (including, without limitation, incidental, direct, 
indirect, special or consequential damages, damages for loss of business profits, business interruption, loss of 
business information) arising out of the use or inability to use this Software, Consumables or related Hardware. 
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